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Introduction

This Rational ProjectConsole tutorial has a modular design so that you can complete sections or ignore sections, based on the development tools your team uses and how you plan to use Rational ProjectConsole.  This section is provided for Rational ProjectConsole administrators who want to learn the basic steps for collecting data from Rational XDE. 

Setup Required

This tutorial collects data from the Rational XDE Getting Started model.

You can do either of the following:

· Use the model that you downloaded with this tutorial and copy it to your C:\Temp directory.

· Create your own Getting Started model and copy it to your C:\Temp directory.

Configuring Rational ProjectConsole to Collect Rational XDE Artifacts

A Rational XDE model contains different types of artifacts, including use cases, packages, classes, and diagrams.  You can use Rational ProjectConsole to collect information about these artifacts. You can create a collection task that counts of each of the artifact types and collects artifact attributes.

In this section, you’ll set up and run a task to collect Rational XDE nested elements information, which you will then use to create a trend chart that shows the number of classes in the Rational XDE model over time.

The exercise sequence in this section walks you through all of the tasks required to collect Rational XDE artifacts. The tasks you will perform are:

Part 1 – Create a domain source template for collecting Rational XDE artifacts.

Part 2 – Create the target tables in which Rational ProjectConsole will store the extracted data.

Part 3 – Map the source fields in the Rational XDE model to the fields in the Rational ProjectConsole repository target tables.

Part 4 – Define a collection task that provides Rational ProjectConsole with all of the information required to collect the Rational XDE artifacts.

Part 5 – Run the collection task to populate the target tables with sample Rational XDE data and view the results.

Part 6 – Create a metrics panel to graphically display the results of the completed data collection.

Part 1 –  Creating a source template for Rational XDE
In this first exercise, you will create a domain source template that you will use to collect the Rational XDE sample artifacts.   
	
	Use case steps
	Details
	Display

	11.1.1 
	Start your Web browser and log in to the Rational ProjectConsole Web site.  

Note You can log in from the Rational ProjectConsole server or from a client.
	Start your Web browser, and type the following URL:

http://server_machine/projectconsole

where server_machine is the name of your Rational ProjectConsole server.

In the User ID box, type “admin.”

In the Password box, type “changeit.”

Click Log In.
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	11.1.2 
	
	The welcome page for the sample project ClassicsCD.com is displayed in the right frame.
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	11.1.3 
	Start the Designer.
	On the Rational ProjectConsole toolbar, click Designer.
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	11.1.4 
	Create a new domain source template for collecting the sample Rational XDE artifacts.
	On the Designer File menu, point to New, and then click Domain Source Template.  

Alternatively, on the Designer toolbar, click Create Domain Source Template.
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	11.1.5 
	Name the new domain source template.
	On the General tab, in the Name box, type “XDE Source Template.”

Click the Source Fields tab.
	[image: image7.png]Domain Source Template 1091273158% =101x]

General | sourceFiets |

e : XD Bource Termpiats

Description






	11.1.6 
	Specify the name of the machine from which to access the Rational XDE model.
	Under Source Details, next to the Host Name box, click Select.
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	11.1.7 
	
	In the Hostnames list, select the name of the machine to use to connect to the Rational XDE model.

For this exercise, select <ProjectConsole Server> because the Rational XDE model is stored on the Rational ProjectConsole Server.
Click OK.
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	11.1.8 
	Specify the domain for the source data to collect.
	The Source Fields tab displays the name of the host machine that you selected.

Under Source Details, next to the Source box, click Select.
	

	11.1.9 
	Select the Rational XDE source domain.
	In the Domains list, select XDE.

Click OK.
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	11.1.10 
	Select the root artifact for the source query.

The root artifact is the starting object for a given source object model.  

For Rational XDE, this is the Model artifact.
	The Source Fields tab shows that you selected the Rational XDE domain.

Under Source Details, next to the Root Artifact box, click Select.
	

	11.1.11 
	
	In the Artifacts list, scroll down and select Model.
Click OK.
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	11.1.12 
	
	The Source Fields tab shows that you selected Model as the root artifact.
	

	11.1.13 
	Specify the path to the Rational XDE model.
	Under Parameters, in the Value box for Model.Path, type “C:\Temp\Getting Started.mdx.”

Under Source Fields, click Browse.

Note  You can only open the Browse Source window after you enter all of the required values under Source Details.
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	11.1.14 
	Specify the source fields to extract.
	If the model is large, you might experience a delay while the model is loaded into Rational XDE.
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	11.1.15 
	Iterate on the nested elements in the Rational XDE model. 
	In the Source Items list, expand Model, and  scroll to and double-click NestedElements.

In the Selected Items list, expand Model. The NestedElements node is displayed.  
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	11.1.16 
	Set up the recursion.

To iterate recursively on the nested elements in the Rational XDE model, you must iterate on the nested elements of the nested model elements returned by the previous query.
	In the Source Items list, expand NestedModelElement, and scroll to and double-click NestedElements (this is the last item under NestedModelElement).

In the Selected Items list, expand NestedModelElement. The NestedElements node is displayed.  
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	11.1.17 
	Select the nested model element attributes you want to collect.


	Under Source Items, expand NestedModelElement, and then double-click Name and TypeName.

You will see that, in the Selected Items list, Name and TypeName are displayed under NestedModelElement.

Click OK.
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	11.1.18 
	Save your new Rational XDE source template.


	The Source Fields table lists the selected source fields.

On the Designer File menu, click Save.

Alternatively, on the Designer toolbar, click Save.
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	11.1.19 
	After you create and save the new source template, Rational ProjectConsole can create all of the metadata (target tables, a mapping, and a collection task) required to use the template for data collection. 

In this exercise, you will create the metadata manually.
	Click No.
	[image: image19.png]create Metadata

The source template has been successfuly created,
0 you want ProjectConsole o create the accompanying
mekadata (tables, mapping, colction task)?

=






	11.1.20 
	Close the Rational XDE Source Template window.

Leave the Designer open.
	
	


Part 2 –  Defining target tables and fields for Rational XDE artifacts

In this exercise, you will define the measure table and dimension tables that the collected Rational XDE artifacts will populate.  

	
	Use case steps
	Details
	Display

	11.2.1 
	Check out the warehouse schema.

Because warehouse tables make up the schema, before you define them, you must first check out the schema.  
	In the Designer, click Schema > Check Out.

Alternatively, on the Designer toolbar, click Check Out.
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	11.2.2 
	Type comments about the schema checkout. This is optional.
	In the Comments box, you can type information about the checkout.

Click OK.
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	11.2.3 
	Acknowledge the successful warehouse schema checkout.
	A message box is displayed and lets you know the schema checkout was successful.

Click OK.
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	11.2.4 
	Define the dimension tables for the Rational ProjectConsole repository.

To define a schema for data collection, you must first define the dimension tables that contain a single dimension field, and then define a measure table that references the dimension tables.
	On the Designer File menu, point to New, and then click Dimension Table.

Alternatively, on the Designer toolbar, click Create Dimension Table.
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	11.2.5 
	Name the new dimension table.

Tip  Although it is not required, using a naming convention for your target tables is a good practice.  The convention used here is to append “_dim” to signify a dimension table and “_measure” to signify a measure table.
	In the Name box, type “ElementName_Dim.”

Click the Target Fields tab.
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	11.2.6 
	The Designer creates a single field in the new dimension table and assigns it a default name. 

Rename the field. 
	In the table, click the row that contains the new field information.

Click Edit.
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	11.2.7 
	Give the field a descriptive name.
	In the Name box, highlight the default name, and then type “ElementName.”

In the Description box, you can type a description for the field. This is optional.

Leave the default values in the other fields.

Click OK.
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	11.2.8 
	Save the dimension table.
	The dimension table is updated with the new field name.

On the Designer toolbar, click Save.

Close the target table window.
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	11.2.9 
	Create a dimension table to store the TypeName source field.
	Repeat steps 11.2.4 through 11.2.8 to create the following additional dimension table:

Table Name: ElementTypeName_Dim

Field Name: ElementTypeName
	

	11.2.10 
	Create a new measure table.

To complete the schema, you’ll define the required measure table.  The measure table consists of measures and references to dimension tables.  The references to the dimension tables signify the attributes of a measure.  
	On the Designer File menu, point to New, and then click Measure Table.  

Alternatively, on the Designer toolbar, click Create Measure Table.
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	11.2.11 
	Name the new measure table 
	The target table design window is displayed in the right frame.

On the General tab, in the Name box, highlight the default name, and then type “XDE_Measure.”  

Click the Target Fields tab.
	

	11.2.12 
	Add a new target field to the measure table.
	On the Target Fields tab, click Add.
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	11.2.13 
	Name the field and assign it to reference the ElementName_Dim dimension table.

Tip  Although it is not required, using a naming convention for your target fields is a good practice. The convention used here is to append “_fk” to signify a reference field (foreign key notation).
	In the Name box, type “ElementName_fk.”

In the Type list, select Reference.

In the Reference list, select ElementName_Dim as the dimension table to reference.  

Leave the default values in all other fields.

Optional  In the Description box, you can type a field description. 

Click OK.
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	11.2.14 
	Create another target field that references the TypeName_Dim dimension table.
	Repeat steps 11.2.12 and 11.2.13 to create the following reference field:

Name: ElementTypeName_fk 

Type: Reference

Reference: ElementTypeName_Dim 
	

	11.2.15 
	Create another target reference field to reference the project_dim dimension table. 

This dimension table already exists in the sample Rational ProjectConsole repository so you do not need to create it.
	Repeat steps 11.2.12 and 11.2.13 to create the following reference field:

Name: Project_fk 

Type: Reference

Reference: project_dim 
	

	11.2.16 
	Rename the measure field.

Every measure table contains a default measure field (named “measure”) that is used to store the count for number of rows or records in a measure table.

Give this field a more descriptive name.
	On the Target Fields tab, under Display Name, click measure.

Click Edit.
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	11.2.17 
	Edit the measure field.

It is a good idea to give this field a name that reflects the type of data being collected. Because Rational ProjectConsole will use this field to count the number of elements in the Rational XDE model, name it “Num XDE Elements.”
	In the Name box, select the default name, and then type “Num XDE Elements.”

Leave the Non additive check box selected.

In the Description box, you can type a description for the field.

Click OK.
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	11.2.18 
	Save the table and close the window.
	The target table window displays the new field name.

On the Designer File menu, click Save.

Close the target table design window. 
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	11.2.19 
	Check in the target schema.
	Click Schema > Check In.

Alternatively, on the Designer toolbar, click Check In.
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	11.2.20 
	Add comments.
	To document the check in, type a comment in the Comments box. This is optional.

Click OK.
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	11.2.21 
	Acknowledge the schema check-in. 

Leave the Designer open.
	A message box lets you know the check-in was successful. 

Click OK.
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Part 3 –  Defining a mapping

In this exercise, you will use the Designer to map the target fields in the warehouse tables to the source fields that contain the sample Rational XDE artifacts.

	
	Use case steps
	Details
	Display

	11.3.1 
	Create a mapping for the Rational XDE collection.  
	On the Designer File menu, point to New, and then click Mapping.

Alternatively, on the Designer toolbar, click Create Mapping.
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	11.3.2 
	Name the new mapping.
	In the Name box, highlight the default name, and then type “XDE Mapping.”
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	11.3.3 
	Select your Rational XDE_Measure table as the target table for the mapping.
	Click the Mappings tab.

In the Target Table list, select XDE_Measure.
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	11.3.4 
	Select the “XDE Source Template” you created as the source template for the mapping.
	In the Source Template list, select XDE Source Template.
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	11.3.5 
	Map the “ElementName” target field to its corresponding source field.
	Next to the ElementName item under Target Field, click the Source Field box, and then, from the list, select NestedModelElement.Name.
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	11.3.6 
	Map the remaining target field to its corresponding source field.
	Next to the ElementTypeName item under Target Field, click the Source Field box, and from the list, select NestedModelElement.TypeName.
	

	11.3.7 
	Some listed target fields, such as “project,” are not collected from the Rational XDE model. You assign these fields default values. 

Assign a default value to the “project” target field.
	Under Default Value, next to the project item under Target Field, type “Tutorial.” 
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	11.3.8 
	Save your mapping settings and close the mapping window.

Leave the Designer open.
	On the Designer File menu, click Save. 

Alternatively, on the Designer toolbar, click Save.

Close the mapping window.
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Part 4 –  Defining a collection task

A scheduled task contains all of the information necessary to run a task such as data collection. In this exercise, you will define a Rational XDE collection task.   

	
	Use case steps
	Details
	Display

	11.4.1 
	Create a scheduled task.
	On the Designer File menu, point to New, and then click Scheduled Task.

Alternatively, on the Designer toolbar, click Scheduled Task. 
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	11.4.2 
	Name the scheduled task.
	Under Task Information:

· In the Name box, type “XDE Collection.”

· Next to the Hostname box, click Select Hostname. 
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	11.4.3 
	Specify the name of the machine on which the collection task will run.

Note  The host machine you specify for the task overrides the host specified for the domain source template. 
	In the Hostnames list, select the name of the machine to run the collection task. 

Note  Selecting <ProjectConsole Server> will run the collection on the Rational ProjectConsole server.

Click OK.
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	11.4.4 
	
	Under Type of Task, next to the Metrics Collection box, click Select Mapping.
	

	11.4.5 
	Select the mapping to use to collect the Rational XDE artifacts.
	In the Mappings list, select XDE Mapping.

Click OK.
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	11.4.6 
	You can schedule your collection task to run daily, weekly, or monthly. In this exercise you will not define a schedule for your task. Instead, you’ll run the task manually. 

Save the scheduled task.
	On the Designer File menu, click Save.

Do not close the task window.
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Part 5 –  Running a collection task

In this exercise, you will run the Rational XDE Collection task that you created in the last exercise.  

	
	Use case steps
	Details
	Display

	11.5.1 
	Run the collection task that you created in Part 4.
	Make sure that the Rational XDE Collection window is open in the right frame (if it is not in the Designer navigation tree, expand Scheduled Tasks, and then click XDE Collection).

Click Task >Run. 
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	11.5.2 
	Acknowledge the collection task start message.
	The Designer displays a message to let you know that the task has been started on the host you specified.

Click OK.
	[image: image50.png]Task Scheduler £






	11.5.3 
	View the Scheduled Task Logs table. This table lists all task logs, with the latest run displayed in the first row.
	In the Designer navigation tree, scroll down to and then click (do not expand) Scheduled Task Logs.
	

	11.5.4 
	A task log shows the name of the host on which the task was run, the task completion status, the start time, end time, and, if an error occurred during the run, an error code and message.

A task log also shows the number of measures (rows) collected.

You can refresh the log manually.

When the status shows SUCCESS, the collection has completed successfully.
	To make it easier to view the information in the table:

· On the Designer View menu, click Navigation Tree.

· Maximize the Scheduled Task Logs window.

Information about the Rational XDE Collection task is displayed in the top row.
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	11.5.5 
	View all information about the Rational XDE Collection task run.
	To see the complete log of the Rational XDE Collection task run, in the Scheduled Task Logs window, double-click the top row.

After the Status box displays the value SUCCESS, the collection task run is completed.

Note that 25 measures were collected.

Close the Rational XDE Collection task log window.

Close the Scheduled Task Logs window.

Close the Rational XDE Collection task window.
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	11.5.6 
	Close the Designer.
	On your Web browser File menu, click Close.
	


Part 6 –  Viewing results

At this point, you’ve collected some Rational XDE artifacts in the sample warehouse that you can now view the results. In this exercise, you will use the Rational ProjectConsole Dashboard to create a metrics panel and a trend chart to display the results.  

	
	Use case steps
	Details
	Display

	11.6.1 
	From the Rational ProjectConsole Web site, start the Rational ProjectConsole Dashboard.
	On the Rational ProjectConsole Operations toolbar, click Dashboard.

Note  Depending on your set-up, your connection to Rational ProjectConsole Web site may have timed out. If this is the case, you must to log in again.
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	11.6.2 
	
	The Dashboard starts up in a new Web browser window.
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	11.6.3 
	Create a metrics panel in the ClassicsCD.com Projects folder.

In Rational ProjectConsole, you can create metric displays such as charts and gauges and organize them in a metrics panel. You can then publish the metrics panel for viewing on the Rational ProjectConsole Web site.  

In this exercise, you will first create a metrics panel, and then add a metric display to it.
	In the Dashboard navigation tree:

· Expand ClassicsCD.com Projects.

· Expand Point of Sale (POS).

· Expand Functional Teams.

· Click the Architecture folder.

On the Dashboard File menu, click New Metrics Panel.

Alternatively, on the Dashboard toolbar, click New Metrics Panel.
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	11.6.4 
	Rename the metrics panel.

Give your metrics panel a descriptive name that you can recognize in the navigation tree later.
	In the Dashboard navigation tree, expand the Architecture folder. Right-click the default name for the metrics panel that you just created (Metrics-Panel-1), and click Rename.
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	11.6.5 
	
	In the label box for the metrics panel node, select the default panel name, and then type “XDE Artifacts.”

Press enter.

The title bar of the metrics panel window displays the new name.
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	11.6.6 
	Add a trend chart to your metrics panel.

You can create two kinds of charts in Rational ProjectConsole – trend charts and distribution charts.
	 Click Insert > Chart.

Alternatively, on the Dashboard toolbar, click Insert Chart.
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	11.6.7 
	Set the chart to display the number of Rational XDE elements over time.
	In the Chart Type list, leave Trend selected.

In the Interval list, select Week.

Under Available Fields:

· In the Y-Axis list, scroll to and select Num XDE Elements.

(A check mark is displayed to the left of the item you select.)

· In the X-Axis list, select collectiondate. 

Under Current Selection, click Filters.
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	11.6.8 
	You can use filters to narrow down the data displayed. In this chart, you’ll filter on ElementTypeName, “Class.”
	The Filters window is displayed.
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	11.6.9 
	You must set up each side of the <Filter> Operator <Value> equation independently.  You will first specify the field to filter on, and then specify the value on which to base the filter.
	In the Select Field list, double-click ElementTypeName.

This adds ElementTypeName to the Filter column in the Define Filters table.

Click Values.
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	11.6.10 
	
	In the list of values, select Class.

Click OK.
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	11.6.11 
	
	The Filter window is updated with the new value.

Click OK.
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	11.6.12 
	Change the chart display type to bar chart.
	In the Chart Properties window, click the Format tab.

In the Display Type list, select Bar Chart.
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	11.6.13 
	Change the chart title, and then generate the chart.
	Click the Labels tab.

In the Title box, select “Metric Display-1,” and then type “Num XDE Classes By Week.”

In the X-Axis, type “Week Number.”

To generate the chart, click OK.
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	11.6.14 
	View the chart.

This chart can be used to assess model complexity (as indicated by the number of classes) over time.
	Your new bar chart is displayed in the Rational XDE Artifacts metrics panel.

It shows that the model contained five classes on the day you ran the collection.

Note The chart only shows one bar because you have collected data only once. After you have collected data over several weeks, the chart will display several bars that indicate a trend in model complexity.
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	11.6.15 
	Save the metrics panel.

You can add more metric displays to this panel on your own if you want to.
	On the Dashboard File menu, click Save.
	

	11.6.16 
	Close the metrics panel and quit the Dashboard.
	In the right frame, close the metrics panel.

Close your Web browser window.
	


Conclusion

Congratulations!  You have successfully populated your Rational ProjectConsole repository with Rational XDE artifacts stored in a Rational XDE model and viewed the results in a trend bar chart.  Let’s review what you did.

You used the Designer to:

1. Create a source template to identify the artifacts to collect. In this case, you collected Rational XDE model elements. You specified the name and typename as the element attributes to collect.

2. Create the warehouse measure and dimension tables to store the collected artifacts. You defined dimension tables for the attributes and a measure table containing relationships to the attributes (dimension table).

3. Define a mapping to specify where to store the source artifact attributes.

4. Create a collection task by identifying the host machine to run the collection on and the mapping to use for the task.

5. Run the task you created and check the task run results.

You used the Dashboard to:

1. Create a metrics panel with a bar chart to display the artifact collection results.
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